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Tec Basic

Notice To Windows 95, 98, ME, Win 2K Users
Microsoft has discontinued their support of Windows 95, 98, ME
and Windows 2K.
Selcom Secured Version 6 for use in
Windows 95, 98 & ME can no longer be supported .
Tip: If you don’t know which version you’re running, our manual (page 6)
will walk you through finding out.
WARNING : If you are running any custom
or non-compliant Windows software
you should check with your software
provider to insure adding this application
will not affect your other programs !

1. Do not install unless your Software Version is Windows XP, Vista,
or Windows 7.
2. Quit any applications that are currently running.
3. If you are running the Office toolbar, click on the Windows flag
and exit the toolbar.
4. If necessary, terminate any Anti-Virus programs.
5. For Windows Vista and Windows 7 users, ensure that User
Accounts Controller is active and enabled and administrative
privileges are active before installing Selcom software.
SEE NEXT PAGE.
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HOW TO TURN ON USER ACCOUNTS CONTROLLER IN WINDOWS 7:
Click on Windows button in lower left of desktop.
Type in: “UAC” in the search window.
Set slider to 3/4 position as shown.

HOW TO TURN ON USER ACCOUNTS CONTROLLER IN WINDOWS VISTA:
Click on Windows button in lower left of desktop then click on Control Panel icon.

Next, click on
User Accounts icon
In Control Panel.

Finally, click on
“Turn User Account
Control on or off”
and make certain it
is ON.

WARNING:
INSTALLING TECBASIC WITHOUT USER
ACCOUNT CONTROL TURNED ON FIRST WILL
CAUSE THE PROGRAM TO OPERATE
INCORRECTLY.
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Tec Basic

Auto Port Locate Feature
Ver 6.0. Bld 2 and above
Some of our customers have experienced difficulty determining which serial port on their computer is
active, in order to communicate with our telephone access units. In order to assist our users, a feature
has been added to Selcom Tec Basic.
An Auto Port Locate function has been added to the Unit Data Screen.
Click on the Find Unit tab and it will display: Testing Com Ports—Please Wait . . .

If a Com Port attached to a Tec unit is detected it will display the appropriate Com Port number, (as
shown below) which can then be selected by the drop-down menu to choose the correct port.
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Tec Basic
Tec Basic
System Requirements
Operating System:
Windows XP (Home or Professional) Service Pack 3
Windows Vista (All editions) Service Pack 2
Windows 7 (32 or 64 bits, All editions)

Hardware:
Computer
System Properties
(Screens may appear slightly
different with different versions of
Windows.)

> Pentium 4 Recommended

System RAM or
Total Memory

128 Mb. Recommended

Available Space or
Hard Disk Storage
Required

20000 KB or 20 Mb.
plus 2 - 15 Mb. per site

Installation Drive

CD-ROM “R” Reader for
installation of Software

System Requirements to install this Software

1) Installation Screen

2) Select Installation Type

This program requires 20.0 megabytes of hard disk and
includes 12 megabytes of system files that may need to be
installed. You therefore need a minimum 32 megabytes of
space to install this program for one site. Additional sites
require 2 to 20Mb. per site, depending on site size and the
amount of backups used. During operation, Tec Basic will
require up to 32mb. of free ram to operate efficiently
depending on the size and model of the unit .
With less memory the program may operate, but with
poor performance. 128 MB of RAM is recommended.
This program will only operate correctly in Windows 2000,
Windows XP and Windows Vista (all editions). If you are
unsure, select the “My Computer icon on your desktop and
RIGHT click it. Once the panel is opened, select Properties
and LEFT Click it. A “Systems Properties” screen will open
and under System:, it must say:
Windows XP (Home or Professional)
Windows XP (Professional w/SP-2)
Windows Vista (all editions)

3) Setup Wizard Screen
Page 6

If it does not, contact Microsoft or your local computer dealer
for a compatible operating system.
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Tec Basic Installation Instructions
Setup will warn you to Shutdown any running programs.
You MUST shutdown “Microsoft Office” as it will
disrupt the installation.
If you are running the “Office Toolbar”, you MUST close
the Office Toolbar and all it’s applications and you should
close any other applications running to insure a proper
installation. You may or may not, have to turn anti-virus
programs also.
(Installation screens start on page 6.)
Once you have checked that you have the proper Revision,
place the CD ROM disk into your CD-ROM Drive.

4) Choose Directory
Versions of Tec Basic are isolated and protected.
Isolation:
Tec Basic has been rewritten into a Tec Basic version that
allows Microsoft library files it uses to be isolated for it's
own use and not shared with other applications.
Protected:
When the Tec Basic program is activated Library files that
may have been deleted, changed manually or
damaged by a virus are restored automatically by the
computer system, when possible, or the Tec Basic installation CD will be automatically asked for by name so the
computer can reinstall damaged or deleted files.
Setup will warn you to Shutdown any running programs.
You MUST shutdown “Microsoft Office” as it will
disrupt the installation.
If you are running the “Office Toolbar”, you MUST close 5) Installing........
the Office Toolbar and all it’s applications and you should
close any other applications running to insure a proper
installation. You may or may not, have to turn anti-virus
programs also.
If your main files (Windows Installer) are out of date,
setup may prompt you to restart your computer. After
doing so, start setup again.
Confim the proper location.
Tec Basic setup has a standard location for its files, but will
give you the chance to choose another location and name of
the directory, then will install the program. It is recommended to let the program install into it’s default location,
so any update installs properly.
Tec Basic uses a “Completion Gauge” to indicate the
percentage of the installation completed.
6) Complete.
If files in your computer are damaged, setup will inform
you of the fact, and abort the installation.
At the end of the installation, Setup will indicate a complete
and proper Installation.
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Double-clicking on the desktop icon will show the startup “splash” page.

To disable startup splash screen, check the check box
as shown.
Interested in our other products? Selecting “Go To
SES Manuals Web Site” will take you to our web site
manuals page. You must have an internet connection
available for this feature to function.
If you have questions about the operation of the Tec
Basic Software during operation, you may select the
“View Software Manual” from the “View” Menu.
You must install “Adobe Reader ™” for this feature to
function.

A RAM (Random Access Memory) memory usage indicator has been added to the Main Page and the communication pages. If the indicator turns yellow you should not start any additional programs. If the indicator
turns red, you should not attempt to communicate with any of your telephone access units. If the memory indicator shows insufficient memory to operate, the program will stop. As this may occur during transmission,
your should not attempt to communicate, when your memory usage is high. (Bar is yellow, or red.) Other applications may have to be stopped to free up RAM. The absolute value will vary from computer to computer.
Page 8
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Tec Basic
Startup and Operation

Start-up Screen

Login Screen

Main Screen after Startup
Showing Pull-Down menu
available without any Site
Selection made

Tec Basic software is only for use with TEC Units with a
modem, NIC, or serial card installed.
Startup
Tec Basic places a menu selection in your Startup Directory.
Select and the Log-in will appear. Tec Basic is shipped from
the factory with the Name “selcom” and the Password
“selcom” (Note lower case) installed in the password
database. Type this name and password in exactly and the
main menu will appear.
Help
Help is provided for each item. To use, place the
mouse pointer over the item you need assistance with and a
description or instructions will appear on the screen
automatically. This feature is provided on all screens.
Main Menu
The Main Screen appears blank with only several selections
possible.
⇒ Select TEC Unit to Edit / Change [Window]
⇒ The Following Menus
⇒ File
⇒
Edit TEC Unit Data
⇒
Add TEC Unit (Wizard)
⇒
Exit
⇒ Help
⇒
About Tec Basic
⇒
Show Splash
⇒ Add Unit [Button] (Wizard) (if allowed by password
level )

Tec Basic is shipped with a set of example Units available to
allow you to view and learn this program. You may wish to
start with selecting this Unit and using it to explore the
features of Tec Basic. These instructions are written using
Main Screen w / Sample selected
“Sample- 4Reader” as its example. If you wish to start by
setting up your unit, go to the section of these instructions for
the “Add TEC Unit (Wizard)”. Or continue by selecting
“Sample - 4Reader” in the center selecting window. As you
add your Unit(s) this selector will expand to show all units
installed in the software in alphabetical order for your
convenience. There is no limit to the number of TEC units
Main Screen w/Multiple Unit Selected allowed, except the physical capacity of your computer.
Each unit installed uses about two to fifteen megabytes of
Showing Command Buttons and
storage space depending on the size of the unit and the
Menu’s available after Site
number of backups used. After the selection is made,
Selection is made.
“Command Buttons” will appear and the menu system will
Page 10
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expand to include the features ALLOWED by the authority
level set to each Name/Password. Name/Password “selcom”
is provided with FULL authority. You may delete this
Name/Password AFTER assigning a new name with FULL
authority.
Login Passwords
Select the Login Passwords in the “Edit “ Menu.
The “Password File” Screen will appear showing all the
Login Names/Passwords in the system with their authority
levels. To add select “Add New User” command button or
to Edit a User, Select that name and “double click” it with
View Login Passwords
your mouse button. This will make the screen change to
allow editing or deleting of the record. If you erase all
Showing Password List in Name Order.
names /passwords with the authority level of “1”, the system
adds back “selcom” / “selcom” with the authority level of
Authority Level
Level Level Level Level
Settings
1
2
3
4
“1”as the only password to prevent you from locking
X
Rename
Files
yourself out of the system.
X
X
Use the Add Unit Wizard
Authority Levels
TEC Basic has several levels of authority. This
X
Edit / Change Passwords
authority system allows the owner to decide what privileges Edit the Unit Data
X
each user will use to operate the system. The levels of
X
X
X
Use the Entrance
Configuration
privileges are as shown in the adjacent Table.
X
Change Data File Name in
Tec Basic Organization
Unit Data
Tec Basic is organized into logical groups. These
X
X
X
Use the System Configuration
groups are distributed as follows:
X
X
X
X
Use the Add/ Edit Directory
⇒ Login Control & Maintenance
X
X
X
X
Get All Data
⇒ Unit Directory Control
X
X
X
X
Get System Configurations
⇒ Unit System Configuration
X
X
X
X
Get Directory
⇒ Unit Entrance Control
X
X
X
Send all Data
⇒ Unit Configuration
Send System Configuration

X

X

X

All operations are accessible from the Main Menu Screen.
The most used functions are available using the Command
Buttons. All operations are available with the Menu System.

Menu’s available after a Site Selection is
made with Level 1 password privileges.
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Setting a Default Unit
Tec Basic has the ability to return to the same unit, every time you start the program. You may
turn on this feature by selecting “Default Unit” under the “Options Menu” or by selecting “Default
Unit” in the “Options Screen” in the “Edit TEC Unit Data “ screen.

To select the unit you wish to automatically load when the program starts, you must do the following:
1. Select the unit on the main screen
2. Select “File”
3. In the File sub menu select “Edit TEC Unit Data”
4. On the “Unit Data” screen locate and select “This is the Default Unit”
5. Select Finished
6. If the “Default Unit” is selected under the “Options”, the selection will automatically load when
you start the software or return from “Edit TEC Unit Data”.
7. You may select other units and work within them without unselecting “Default Unit”. It will only
change back when you start the software or return from “Edit TEC Unit Data”.
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Auto Tune Feature
Ver 5.2 Bld 184 and above
Some of our customers have experienced difficulty communicating with our telephone access units. We have found a problem to be the use of phone circuits with long delays. In
order to assist our users, a feature has been added to TEC Basic.
An Auto Tune function has been added to the Communication module.

Each time, during the Call to the unit, the delay time and connected baud rate is measured.
The software then adjusts the communications to these measured rates. There is an indication
of this action during the call in the visible call log (above). It shows the tuning process and
the resultant adjustments. There is no user input required.
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Unit Directory Control
Tec Basic incorporates a new style Directory view and
editing system. Note that the Unit Site name is featured at
the top of the screen. This feature is present on each screen
to assist the user. The Directory display is in a Columns
and Rows format showing ALL codes in the directory. The
opening display is sorted in alphabetical order. Additional
help is provided by selecting the “Help” Command button.
The Elevator bars appear when needed and allow the user to
move through the list of names and to view the additional
data for each name. The user may use the mouse arrow to
single click on any code number or name to highlight that
row. This provides a marker on the record chosen to use as
the display is moved to the right in order to display the
additional data.
The user may use the mouse pointer to single click
on the TOP of any column to SORT the display by that
column. If a reverse (Z to A or 9 to 0) order is desired, a
check box is provided above the listing. The user should
select the direction of sort desired, then select the column to
sort by. The user may use the mouse pointer to single click
the sort option and it will toggle from normal to reverse and
back to normal. Gauges are provided near the bottom of the
screen to inform the user of the number of Unit Codes and
the number of Phone Numbers in the Directory. This may
be used to determine the percentage of the Unit capacity
used. In Displays larger than 640 x 480, the user may
enlarge the view by dragging the edges of the directory.
The number of updates to be sent and the number of deletes
(if applicable) are also shown.
♦ NUMBER: This is the Code Number used by the
Unit User to dial the Name shown in the Directory. It
can be configured to show 1 to 6 digits. Internally it is
always stored and used as 6 digits. If set to display
three digits, then the number is dialed using the three
displayed digits.(123456 is displayed as 456). However, Code (000456) would be dialed. This allows it to
appear to allow more than one name to use the same
code. Example: Codes 000234, 001234, 011234 and
101234, all would display 234 showing different names
with the 234 code number. The 000234 phone number
would be dialed. Directory Code Length is set using the
“System CFG” command button or “System
Configuration” under the “Edit “ Menu Selection.
S: (SEND) The ‘Send’ field indicates if this name would
be updated on a ‘Send Updates’ command. Only the
names marked would be sent. When a name is
Page 14

Unit Directory Spreadsheet View

Unit Directory Edit / Add mode

Directory Limits
Code Number

1 to 6 Digits

Name

up to 14 Characters

Phone

up to 14 Digits

PIN

1 to 6 Digits

Card Number

5 digits to ‘65564’

Directory Limits
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♦
♦

♦

♦

♦

♦

selected to edit, the send box is automatically checked.
N: (NEW REC) The “New Record” field shows a “Y”
when a Code was received from the unit that did not exist in
the database. This will occur when a code is input directly
into the unit.

*Optional Field Capacities
PARK 1

9 Characters

PARK 2

9 Characters

PARK 3

9 Characters

D: (DELETE) The “Delete” field is marked “Y” when this
record will be deleted on the next update. Note: In TEC 101
units, You may reuse the code number at any time,
however. See Send Updates on page 33.

EMR PHONE

14 Characters

LIC NO 1

10 Characters

LIC NO 2

10 Characters

NAME: This is the Name shown on the directory display
of the TEC Unit. The user may use up to 14 characters for
each name.

Optional Fields
with User

defined names

Optional 1 to 6

15 Characters

H: (HIDE) Hide inserts a colon in front of the phone
number.

PHONE: This is the phone number the TEC Unit will use to
dial the Name shown. The User may use up to 14 digits
including commas ‘,’ for pauses if required, to dial the Name.
The real telephone number will not show on the unit display
♦ PIN: The “Personal Identification Number” can be
configured to use 1 to 6 digits. The “PIN” is used by the
Named to open the designated entrance. If set to use four
digits, then the number is limited to using the four digits.
(001234 is entered and used as 1234). A 5 digit PIN (11234)
should not be entered and would not operate. Note: To reenter a deleted PIN, You must update the record first.
♦ CARD NO.: If optional access cards or devices are used,
the individual card or device number assigned to this name is
placed here. Card / Device numbers are limited to the
numbers 00001 through 65,534 inclusive. Each Card or
Device may be labeled or named in the Directory. This
information is not stored in the Unit. Note: To re-enter a
Card, You must update the record first.
Optional fields:
♦
PARK 1, PARK 2
♦
PARK 3
♦
EMR PHONE
♦
LIC NO 1, LIC NO 2
♦
Optional 1 to 6 (Can be named by the user)
♦ None of the optional fields are sent to the unit. They are for
the User’s optional use. The text limits are shown in the
aabove Table. Note: If the “Don’t use Fields” option
button is checked in the “Edit TEC Unit Data - Options”
screen, for the “Park” or to “Spare”, the fields selected do
not show in the directory, but the data is not erased. The
names of the individual cards are also hidden, in order to

show a concise view. Checking
“Use Spare Fields” and “Use
Park Fields” shows all.
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Entering New Items into the Directory
Step by step Instructions to enter new items
Tec Basic provides a simple screen to enter
new data into the directory. (See Pages 38—39 for
a handy work sheet to assist the user in entering
the directory.)

Tec Basic Directory
in spreadsheet view

Tec Basic Directory
in edit record view
Directory Limits
Code

1 to 6 Digits

Name

up to 14 Char’s

Phone

up to 14 Digits

PIN

1 to 6 Digits

Card

1 to 5 digits

Directory Limits
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1 On the Main Screen, Select or “Click” the
PROPER UNIT to enter the new items.
2 On the Main Screen, Select or “Click” the
Directory command button. The directory view
screen will appear.
3 On the Directory screen, Select or “Click” the
Add New Name command button. The screen
will change to the Edit / Add view. All of the
entries will be blank.
4 Start the entry by entering the Code Number.
If you are using three digit code numbers(for
example), you only need to enter the three digits
and press the [Tab] key or press [Enter].
5 If the code has been already used, the screen
automatically displays the record and changes to
edit mode. You may change any and all items in
this record, except the code number and the
name. When you send updates, this record
would be changed, except the code number.
6 If the code has not been used, the screen
automatically steps or moves to the name field for
entry. Enter the name before you exit this
window as once entered, the name may not be
changed! You may use the [Tab] or [Enter] key to
move through the windows and enter the
information you require. Only the code number is
required in any record. All other fields are
optional. When you send updates, this record will
be added.
7 When all necessary fields are filled, Select or
“Click” the Update Record (save it) command
button. The record is saved.
8 Select or “Click” the Add command button to
continue entering more data.
9 The information bars update to indicate the
amounts of Unit memory used.
10 To enter more items Go to step 4.
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Unit System Parameters
Tec Basic places all System Configuration Parameters on one screen. Complete
descriptions of each item is available by placing the mouse pointer over each item. The
standard factory defaults are provided as a reference. The defaults will be satisfactory in
most applications. You may change them to provide for new password or directory
♦
♦

♦
♦

Unit System Configuration Standard
Showing Factory Defaults for the
System Data

TEC 1,
TEC1C,
TEC1CA

2 lines of 16
characters

TEC II

2 lines of 16
characters

TEC IV

2 lines of 16
characters
AVANTEC

♦

1 line of 32

TEC– Ten

10 lines of 16
characters

TEC-VISION

6 lines of 16
characters
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♦

♦

Title Page Message Table

TEC VIII,

♦

♦

Directory On - Off - Turns the display of the Directory
On or Off. This does not prevent calling the numbers.
Keypad active - Allows the keypad to be used after
calling allowing for voice mail, etc. Only the numbers 0
to 9 are active, The * and # are not active.
Dial Touch Tone - Changes TEC Unit dialing from
touch tone to rotary or pulse dialing.
Back Beep - Sends a ‘Beep’ tone every ten seconds to
the called party. This allows confirmation that the call
originates from the TEC Unit.
RS232 Baud Select - The serial port baud rate can be
configured from 300 to 9600 baud.
Unit ID (Answer Ring Count) - This is the number of
rings received before the TEC Unit answers. Range is 0 9. 0 means the TEC Unit will not answer. 3 is the
default. The software uses this ID as a confirmation that
it has connected to the proper unit, If the software ID
and the Unit ID are not the same, the software will
indicate an error and will not get or send data.
Title Page Text - See Title Page Table
PRESS # TO VIEW
DIRECTORY is the factory default.
Programming Password - This is the password used to
access and program the TEC Unit. Any combination of
up to six numbers and letters are allowed. 777777 is the
default. Caution: Passwords with letters cannot be
accessed from the keypad or remote touch-tone
control.
Control Password -The control password is used to dial
the TEC Unit from a touch-tone phone and open an
entrance. Range is 00 to 99. The 1st two digits of the
password is the control password in the Tec Basic.
See caution above.
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♦

Site Code - TEC units can use an optional Card reader
module. Set the site code for your cards here. Entering
“255” accepts all site codes. Entering “0 “turns the function off .
♦ Directory Code Length - Sets the displayed code length
from 1 to 6 characters. Set this parameter to the number of
digits you wish to be displayed and entered to dial.
♦ PIN Code Length - This sets the number of characters
used when you use ‘Personal Identification Codes’ to allow
entry.
0 (Off) or 1 to 6 numbers. 4 is the default.
Note: If PIN code length is set to less than the PIN
codes, they will not operate.
♦ Speaker - Mike Open tone - This tone allows you to turn
the TEC Unit microphone on from a touch tone phone and
listen to the activity. Range is 0 to 9. Default is 0 (Off).
Talk Time
- Talk time controls the amount of time the
TEC Unit stays connected to the called number before
automatically hanging up. Range is 1 to 99 Min. Default is 1
min. The TEC Unit beeps @ 10 seconds remaining as a
warning.

System Configuration Table

Item

Range

Default

Directory OnOff

On - Off

On

Keypad
Active

On - Off

Off

Dial touch-tone

On - Off

On

Back Beep

On - Off

Off

RS232 Baud
Select

300 - 9600

9600

Answer Ring
Count

0 (Off) - 9

3

Title Page Text

See Title
Page Table

PRESS # TO VIEW
DIRECTORY

Programming
Password

000000 to
999999
Letters are
allowed

777777

Control
Password

00 to 99

1st two digits of
password

Site Code

0 to 254
255 = All

0 = Off

Directory Code
Length

1 to 6

3

PIN Code

0 (Off) to 6

4

Speaker - Mike

0 to 9

0

Talk Time

1 to 99

1
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Unit Entrance Control

Unit Entrance Configuration

Tec Basic places all entrance configuration data on
one screen. Selector buttons allow selecting the additonal
entrances when installed. Complete descriptions of each
item is available by placing the mouse pointer over each
item. The standard factory defaults are provided as a
reference. The defaults will be satisfactory in most
applications. You may change them to provide for a slow
opening gate or entrance. A Telephone code is installed
to open the first entrance. You may need to change this
and the Open tone for each of the entrances. Tec Basic
will display only the amount of entrances capability.
Showing TEC Reader with settings
♦
♦
♦

♦

♦
♦

Print View - Allows printing of screen with the system
default printer.
Entrance 1-2 Name - Sets the name you will use to
describe this door.
Ent. 1-2 Open Tone. - Sets the touch-tone used to open
Ent. 1 from the called phone. Range is 0 to 9. Zero is
off. Default is 6. Valid for the entrances only.
Ent. 1-2 Latch Tone - Sets the touch-tone used to
‘Latch’ Ent. 1 Open. Range is 0 to 9. Zero is off.
Default is 0.
Strike Out Count - Sets the number of invalid PIN
entries before the system locks out.
Ent. 1-2 Pin on Entrance - Sets the Entrance to be
opened using the PIN numbers. Valid for entrances
only.

Entrance Configuration Table
Item

Range

Default

Entrance 1- 2 Name

21 Characters

Entrance X

Ent.1- 2 Open Time

1 to 99 sec's

10 sec's

Ent. 1- 2 Open Tone

0 to 9, 0 is off

6 on Ent 1

Strike out Count

0 to 9, 0 is off

3

PIN on Entrance

1 to 4

1

Access Control Screen
NOTE: Entrance 3 not Functional on TEC1 systems.
Page 20

July, 2010
Unit Access Control
Tec Basic places all Access Control data on one screen. Complete descriptions of each item is
available by placing the mouse pointer over each item. The Sample TEC101-49 settings supplied are
provided as a reference in the illustrations and will be used to explain the uses.

TEC Series Access Screen

Sample 49 Time Zone Configuration as Shown
Zone

Start
Time

Stop
Time

Days Allowed

0

7:00

6:00

Monday to Friday

1

6:00
AM

6:00
PM

Monday to Friday

2

6:00
AM

6:00
PM

Saturday, Sunday, Holidays

3

10:40
PM

11:59
PM

Monday to Friday

4

12:00
AM

7:20
AM

Monday to Friday

5

8:40
AM

5:20
PM

Monday to Friday

6

7:45
AM

8:15
AM

Monday to Friday

7

4:45
PM

5:15
PM

Monday to Friday

Access Levels
Access Levels are used to attach
Time Zones to specific Entrances. They
may be mixed in any order.
For example, Time Zone 1 could be assigned to Access level 3.

Time Zones
Times Zones allow the User to set up 8 time slots
in a TEC unit. Each Time Zone is a separate continuous
time slot. The sample zones are configured as shown on the
Time Zone table.
Zone 0 shows a time zone starting at 7 am to 6 pm Monday
through Friday. This would be typical of a factory
building open times.Time Slots must end at midnight. To
set up a Group that has access through midnight, you must
use two Time Zones as shown in the example as Time Zone
3 and Time Zone 4. The days of the week may be chosen
for each Time Zone by ‘Checking’ each day you wish to
use. ‘Check the box again removes the selection. The
Holidays box will allow access on the nine dates entered on
the form. In the examples, Time Zone One allows access
from 6 am through 6 pm, Monday through Friday. Time
Zone Two allows access from 6 am through 6 pm,
Saturday, Sunday and Holidays. Time Zone Six allows
access from 7:45 am through 8:15 am, Monday through
Friday. and Time Zone Seven allows access from 4:45 pm
through 5:15 pm, Monday through Friday. This could be
typical of busy times at a Gate entrance and exit.
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Time Zone Wizard
Tec Basic includes a “Time Zone Wizard”
to assist you in setting up your time zones. The
left hand side shows the current settings for the
time zones and the right hand side has the modification tools. In the following example, the user
wanted to setup a time zone to include 8:00 am to
5:00 pm, to automatically open or unlock the front
door. In order to allow the employees time to get
to work and leave after work, the user set the
times in Time Zone 1 to 7:45 am to start and 5:15
pm to stop. The user decided to use Time Zone 1,
Access Level 1 and Access Group 1, just to keep
things as simple as possible. The user selected
the Time Zone Wizard. When the screen appeared, the user
Time Zone Wizard
selected the Time Zone 1 button. The left graph’s moved to
the current settings. Using their mouse, the user moved the Start and Stop pointers to the desired times
and then clicked on the days they wanted the entrance opened. Next the user saved changes in Time
Zone. The left hand graph update to show the current saved configuration.
The user clicked on the “Finished button and returned to the access screen. The user then selected Time Zone 1 to be used in Access Level 1 with Entrance one. Then the user set Access Level
one to be active in Access Group one. Finally, the user set the “Auto Un-lock—Re-Lock for Entrance
1 to Access Group 01. This has the effect of selecting the time zone to unlock the entrance during 7:45
am to 5:15 pm.
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Access Groups
Access Groups are used to allow groups of
individuals card or PIN access by assigning a level or
combination of levels to their group. Access Group Zero is
predefined as an unlimited group. Group Zero allows
access 24 hours a day, ALL days of the year. Access
Groups are assigned to the individuals in the Directory. If
you do not assign a Group to an individual during the
directory entry, Zero (0) is assigned by default.
The examples provided show only a few ways to combine
levels into a group to allow specific access to certain
individuals. For example in Group Six, Access Levels Zero
(0) and One (1) could be selected to allow a group to have
access seven days a week, 7:00 am to 6:00 pm Mon. - Fri.
and 6:00 am to 6:00 pm Sat, Sun and Holidays and using
all entrances as selected.
Holidays
Nine Holidays may be entered in a TEC Series with
a clock and access control. They are entered as two digits
for the month, a slash, and two digits for the day (XX/XX).
If a Holiday is entered and falls on a Mon -Fri, any group
set with a time zone of Mon - Fri without Holidays will not
have access on the holiday. Further, any group using
access levels with time zones without Holiday access will
not have access on the Holiday.

Sample 49 Access Level Table
Level

Time
Zone
Used

Entrances Affected

0

0

Entrance One, Two

1

1

Entrance One, Two

2

2

Entrance One, Two

3

3

Entrance One, Two

4

4

Entrance One, Two

5

5

Entrance Two

6

6

Entrance One

7

7

Entrance One

Sample 49 Access Groups Table
Access Group
Zero (0)

Access levels and Zones Used
None - predefined as unlimited access

One (1) Level Zero using time zone zero with all
entrances 7:00 am through 6:00 PM Mon. Fri.
Two (2) Level One using time zone one with all
entrances 6:00 am through 6:00 PM

Automatic Unlock and Re-lock
You may choose to automatically unlock (or open)
and re-lock (or close) any entrance (or gate) using access
groups. The example provided shows Access Group Seven
used to open the Number One entrance once at 7:45 am to
8:15 am and again at 4:45 pm to 5:15 pm. This example
might be an employee gate that automatically opens during
the peak traffic flow. Another example would be to use
Group Five using Level Five and Time Zone Five to keep
open the Second Entrance during normal business hours.

Three (3) Level Two using time zone two with all
entrances 6:00 am through 6:00 PM, Sat,
Sun and Holidays.
Four (4) Levels Three and Four using time zones
three and four combined to allow access
through all entrances 10:40 PM through 7:20
am, Mon. - Fri.
Five (5)y Level Five using time zone five with
entrance two 8:40 PM through 5:20 PM
Six (6) None, not set to any
Seven (7) Levels Six and Seven with entrance one
during 7:45 am through 8:15 am and then
4:45 PM through 5:15 PM Mon. - Fri.

Sample 49 Auto Unlock / Re-lock Table
Entrance

Access
Group

Access
Level

Time Zone

One

Seven

Six and
Seven

7:45 am to 8:15 am and
4:45 PM to 5:15 PM

Two

None

None

None
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Bulk Loading Information in the Directory
TEC Basic includes a bulk data loader. The
bulk loader can load the following:
1. Phone numbers (Normally used in “No
Phone Bill Systems”)
2. PIN Numbers for Resident/Employee Access
3. Card Numbers to preload a series of cards
prior to issue.
TEC Basic Bulk Loader will allow you to control the increment (sequence step) of any of the
Code Number, Phone number and PIN numbers. The illustrations show examples of bulk
loadings prepared for a TEC Unit. The first
shows an example of bulk loading by column
with a separate card sequence for each column.
Note: the example is showing the following:
1. Code Numbers are incrementing by one.
2. Phone numbers are incrementing by one.
3. PIN Numbers are incrementing by seventeen.
4. Card numbers are incrementing by one.
5. Fifty records are to be modified.
6. Show Load Settings is showing a preview
of what will be entered.
7. If the code numbers already exist, the
new data will be added or existing data
will be replaced. This may be useful to
quickly change all card or PIN numbers in
a system.
You should examine the entries carefully before you select “Enter Data into Directory”.
Once the “Enter Data into Directory” is selected, the changes are made with no undo.
With TEC units, the loader will only load the
first column of cards as that is the limit of TEC
units. The other columns are not applicable
to TECs and are only active when bulk programming CAT units, using Selcom Secured
software, only.
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Add TEC Unit Wizard
Tec Basic provides a ‘Wizard’ to help with the installation of a new Unit. It provides a step by
step method of providing the information required and desired. You will need the following
information at hand to ‘setup’ a new unit in the software (See page 38 for a handy work sheet for
arranging this information)
♦
♦
♦
♦
♦
♦
♦
♦

Your Name for the Unit.
Unit Address (optional).
Unit City (optional).
Unit Type and Model.
Unit Phone Capacity.
Unit Code Capacity (If Used).
Unit Phone Number.
You must have a modem installed into your Windows System if you will be using that to
communicate to the Unit. If a modem is properly installed, you will be able to merely SELECT it
in a pull down selector box. If not, you may select it later using the Edit Unit Data selection from
the File menu.
Using the Wizard
The Wizard takes you step by step through the
information required, providing default answers
when applicable. You may go back to correct
any item without reentering the remaining data
you previously entered. A review is provided at
the finish, allowing you to view all the entries at
one time. If something needs to be changed, use
the ‘Previous’ button to go back and correct the
entry. When you have completed the entries, the
‘Finish’ button will enable and when pressed,
sets up the new unit for you.
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Edit Unit Data
Tec Basic places Unit Data configuration data on one screen. Complete descriptions of each item is
available by placing the mouse pointer over each item. The Wizard is the standard method used to
complete this form . The Wizard also generates the data files needed to store the information for each
new site. This screen is provided to allow changes to be entered when required after a site is created
with the wizard..
♦
♦
♦
♦
♦

♦
♦
♦
♦
♦
♦
♦
♦

♦
♦
♦
♦

♦

Data File - contains the file name for the unit.
Description - contains the Unit’s name you refer to
Street Address - for your reference.
City - for your reference.
Unit Phone - insert the number to be called including any prefixes required. (Example 9,1028812125551212). Up to 32 digits may be used to dial the number used by TEC Basic to
connect to the unit. Note: Tec Basic is compatible with 10 digit local dialing
TEC Model No. - select from list.
Code Capacity - Code capacity you purchased.
Phone Capacity - Phone Capacity you purchased.
Use Modem / Use Serial - how will you connect to the unit to Send data and Get data.
Modem Name - Pull down select for finding the modem in your computer.
Comm. Port - Select the Comm. Port used in Direct Connect.
Baud Rate - Baud rates with modems are automatic.
Maximum Backups - This sets the number of previous sessions the software stores. Once this
number is reached, the backups are automatically rotated, replacing the oldest first. Default is nine
and is recommended.
Next Backup No - shows the position of the current backup.
Multi Unit - Sets software to allow for multiple units on a single phone line and sets sleep mode
active for multiple units on single phone lines.
No. of Units on Directory - Sets software to the number of units connected on ONE phone line
with the same Directory.
Firmware version - All TEC units are Ver. 3.X firmware. You may set this information in the
options screen to configure or reconfigure software for any TEC unit. (See Page 25) Each site
maybe configured differently and the software will then show each site’s features correctly.
Options - This selector allows you to go to the options screen.

Page 26

July, 2010

Options screen for a TEC Unit
Options -Screen
♦
♦

♦

♦
♦

This screen is only available from the edit Unit Data Screen
Unit Firmware Type - set the software screens to the proper firmware version and number of
readers (2 or 4) in the unit. This must match the unit or the software will not allow the user to
connect to the unit. This prevents sending information to the incorrect unit.
Vision Display Settings - allows setting of the TEC Vision display in Ver 3.1X units. This
includes the size of the characters, number of displayed columns, name or calling code first,display
an instruction page and automatically scroll the names on the display. This programming feature
requires firmware Version 3.1X or higher to function. This portion of the screen will only display
if a TEC Vision has been selected as a display type.
Use Park Fields - Sets the software to display the Parking in the directory display. This feature
maybe selected, turned off and re-selected without loss of data.
Use Extra Fields - Sets the software to display the extra fields in the directory display. This
feature may be selected, turned off and re-selected without loss of data.
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MUI Identification When using MUI cards,
these fields allow the user
to enter the ID and their
logical name for each unit.

Standard Report
TEC Basic comes with a standard Directory Report The report is found in the “Reports” menu
selection. It is titled “Print Directory Short by Alpha”. This report has a “Preview on screen” as well
as ability to print any and or all pages and an export utility. With the export feature , you may export
to use the data to view the directory in another program; Microsoft Excel for example. You may also
print the System Configuration and the Entrance Configuration. In order to print Log Reports, you
must upgrade to Selcom Secured.
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Printing the Directory
The “Print Directory Short by Alpha” in the Pull Down Menu, allows you to print the entire directory,
or any portion of the directory you desire.
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Unit Event Log Control
TEC Basic presents a new simplified view of the
transaction log. All information is present and is shown in
a new combined format. TEC Basic provides for
formatting and viewing of the Event Log Buffer
information and maintaining a single, separate log file for
Log Information Provided
each unit or MUI Site. Each site MUI description is placed
ID number of unit
ID
in the log to identify which unit the information is from.
called
Sorting and filtering of the Log Events are available and do
not alter the data in the log. You may use the Sorts &
Site or MUI count
Unit Name
Filters to selectively display and print groups of records in
name of Unit
the log. If your computer has a screen resolution higher
Directory Code No. than 640 x 480, you may resize the Window up to the full
Code
of Event, if
size of your screen to display more data.
applicable
♦ File size limited by the size of your computer storage
capacity, not by the software.
Directory Name of
Name
♦
The Log Display is limited to 23,325 records. Larger
Event, if applicable
files require you to print out the Log to view all the reDirectory Card No.
Card
cords. We recommend purging your log periodically to
of Event, if
keep the size below that limit. More memory may be
applicable
useful to improve performance of printing the report.
♦
Default Sort is by date and time.
Directory PIN No. of
PIN
♦ Sorting is allowed on any column.
Event, if applicable
♦ Temporary sizing of any column is allowed.
Description of event
Activity
♦ Selections and sorting do not change the real data.
Date & Time event
Date
♦ The words “CODE”,’CARD” and “PIN” are removed
occurred
from the messages for clarity.
Log columns separated into logical types to enhance sorting
Partial messages,
Other 1 -2
and selecting.
normally empty.
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♦
♦

Partial messages that result from data wrap in the buffer are deleted.
Automatic update mode prevents most data repetition
In order to insure all messages are entered, the last messages with the same date and time are
repeated.
This feature cannot be used in MUI site logs. MUI Logs are entered in full, so you may have repeats
if you do not erase the log buffer in the units after you receive the log.
Erase to date allows maintaining your log at the size and dates you desire. Erase to date will not work
in MUI Log files. Larger Log files operate slower. Open File add function allows you to add old
logs to the file if required.

Log Search Utility
TEC Basic comes with a Log search utility. Any data to search for may be typed in and ANY occurrence of the data in ANY field will cause the record to show. The Search function is started by selecting the “Search” button on the Log Screen. The grid display will clear and the Search window will
appear. The example shows a search for “Mike” and the results found. The search is performed in
chronological order. The search function searches ALL fields. If the [Search for] text is located in
ANY field, that event is included in the found list.
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Setting your Microsoft Windows Telephone Application Programming Interface
( TAPI )

Long Distance Control
Under some versions of windows, Windows TAPI controls do not handle ten digit dialing
and or long distance correctly. For your convenience, the local area code awareness of Windows is
not used in TEC Basic even if your other programs use it.
This means you will directly control the long distance area codes. In TEC Basic, enter (area prefix
suffix) in the Wizard or in ‘Edit CAT / TEC Unit Data Screen. Place the correct number in the Unit
Phone: window. Example for 10 digit local calling: ‘305-555-1212’. Place any special prefix and
all the numbers necessary and TEC Basic TAPI will dial it exactly for you. This feature allows for
10 digit local calling, same area code long distance calling as well as special carrier long distance
calling as in (1010321,13975551212). TEC Basic allows for 32 digits to be placed into the called
number. Spaces, Parentheses and Dashes are not required and not allowed.

Error Control
TEC Basic uses the advanced TAPI interface within
Windows XP/Vista/Win 7. This allows for a modem to be
installed into Windows System and TEC Basic will use it,
without any need of additional modem strings.
TEC Basic may require that error control be turned off
for connecting to older TEC Units with 1200 baud modems.
We are providing the following instructions to turn off error
control. In order to assist you we have provided the following
setup.
(Screens may appear slightly different with different versions
of Windows.)
Using Start - select ‘Settings’ then ‘Control Panel’ then, if
required by other than Windows XP, ‘Control Panel’.
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Setting your Microsoft Windows Telephone Application
Programming Interface
( TAPI )
continued...

Then select the modem you will
use with TEC Basic. Next select
the ‘Properties’ menu.
Using Control Panel - select ‘Phones &
Modems’.
Note: Your screens may look different if
you have other than Windows XP as
your operating system..

Then select “Advanced” and “Change Default Preferences…”You will need to set
”Cancel call if not connected within” to 120
minimum and 250 maximum seconds if
you are using long ring counts or larger Unit
ID’s
Then...
Using ‘Data Connection Preferences, make sure
‘Data Protocol’ is set to “Disabled” and make
sure ‘Compression’ is set to “Disabled”.. Then
click ‘OK’ and then ‘OK’ again. Exit to the
Desktop and you are finished.
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Get Data from TEC Unit
Tec Basic provides a choice selection screen
to choose the information you GET from the TEC
Unit. During transmission the screen reports
Connection Progress, error correction, record
numbers, elapsed time and other information. The
ID and Firmware version of the unit is checked to
insure the proper unit answered.
Choosing ‘Get All’ will get the configuration and
the directory from the unit. You may choose to get
each item individually. Getting any function will
cause the system to disconnect from the unit after
getting that function, to enable the MUI sleep
system to function automatically. The MUI Sleep
box allows you to disable the unit sleep function
when required and will only appear if selected
during setup.
The system re-configures its settings to match the
unit during the GET DATA process. This includes
Unit capacities and number of names to get from or
send to the unit.
Caution:
When “Get Directory” or “Get All” is used,
the items in the Tec Basic directory are updated.
The directory in Tec Basic is NOT erased. Any
codes in Tec Basic and NOT in the Unit remain. A
warning message would occur prior to getting the
data telling the user that updates exist and may be
lost. If these were codes to ADD in an update, the
update flag on the code or codes to update would
NOT be cleared. If these were codes to CHANGE in
an update, the update flag on the name or names to
update WOULD be cleared and the data would
RETURN to what was in the unit.

TEC Basic has a new feature in
Communications called “Autotune”.
See Page 11 for details.
Function Selected with
Action Log Showing
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Send Data to TEC Unit
Tec Basic provides a choice selection screen to
choose the information you SEND to the TEC Unit. During
transmission the screen reports Connection Progress, error
correction, record numbers, elapsed time and other
information. The system re-configures its settings to match
the unit during the SEND DATA process.
The ID and Firmware version of the unit is checked to
insure the proper unit answered.
Choosing ‘Send All’ will send the Unit configuration and
ALL of the directory data to the unit. You may choose to
send each item individually. Sending Updates will cause
the system to send new and changed directory items only,
then automatically disconnect, providing for a shorter
connection time. The TEC Unit allows you to mark names
for deletion and they will be deleted during an update.
To change relay programming, the welcome
message and other configuration items, you must “Send
Configuration”. You also have the option of changing the
Unit password as you send the configuration to the Unit.
After completing the change, the system enters the new
password into the file automatically. Do not change
passwords while using the MUI functions as the password
will change before connecting to the next unit.
The Multiple Unit Function area allows the operator
to disable the unit clear updates, disable the sleep function
when required and will only appear if MUI functions are
selected during setup. See Page 34 for more detail.
Caution:
When ‘Send Directory” or “Send All” is used, the
directory items in the unit are replaced. Any codes in Unit
and not in Tec Basic are removed. “Send Updates” send
only the codes marked for update. The directory in the unit
is not erased. Any codes marked for update are changed or
added.

Send Screen with
Action Log showing
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Using Multiple Unit Features
The Multiple Unit function allows the operator to control specific
features used with Multiple Unit sites. The features used will
depend on the actual physical configuration . The Multiple Unit
function will only work reliably with the TEC firmware in all
units connected together.
This feature will work with two variations of unit setups.

(Variation 1)
Units connected together on one phone line with the same
directory. Recommended limit is four(4),
Select Multi Unit.
Indicate the number of units to send the same directory or updates
to (2, 3 or 4).
In each unit, set the separate ring counts.

Example
For a site with three units, we suggest setting one unit to two rings,
another unit to four rings and the last unit to six rings. Consult the
technical manual for instructions on using a terminal to make these
adjustments.
Once the ring counts are set, in the Selcom software, Select the unit
to be used for the Send. Go to File - Edit TEC Unit Data. Check
Multi-Unit. Enter the number of units (In our example this is three)
in the No. of Units on MUI window. This sets the software to call
three units and reset the directory updates on the third call.
When the site is called, system will call the first of the units
indicated in the Edit TEC Unit Data Screen one at a time. If you
are sending All or the directory or directory updates, a special
sequence is followed:
1 The first (the one with the lowest ring count) unit is called
first.The ID of the unit is checked to insure the proper unit
answered.
2 This unit (and each following) will be put to sleep at the end of
each transmittal to allow the next unit to answer. The update
flag is not cleared for directory updates until the last unit is sent
or if the clear updates box is checked.
3 A Count-Down window will appear on the Main Screen
showing the units remaining to be called.
Repeat the Send command for each unit allowed as the file used is
common.
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Using Multiple Unit Features
To obtain the information from units, create separate MUI
Identification names in the option screen (See page 25) using
different names for each unit . This MUI Identification will be placed
on the screen. If you desire to check the contents of the individual
directories, it is recommended to used variation 2 to check the
contents as a single directory will not show you any differences.

(Variation 2)
Units connected together on one phone line with the different
directories (using different unit names for each unit). Recommended
limit is four(4).
Select Multi Unit on each of the units.
Indicate the number of units to send as one (1) on all of the units.

Options screen showing
MUI Identifications

Example
When the site is called, system will call the number of units
indicated in the Edit TEC Unit Data Screen. If you are sending All or
the directory or directory updates, a special sequence is followed:
1 The first (the one with the lowest ID) unit is called first.The ID of
the unit is checked to insure the proper unit answered.
2 This unit (and each following) will be put to sleep at the end of
each transmittal to allow the next unit to answer. The update flag
is not cleared for directory updates unless the clear updates box is
checked sent. This is automatically set when the current unit
becomes the last to send to.
3 Select each unit in turn and repeat the Send command for each
unit.
4 Getting all information from the units is allowed as the files used
are separate. To obtain the information from units, select each
unit in turn and perform the upload or download function desired.
5 The system will automatically put each unit to sleep unless the No
Sleep selection is made.
Do’s and Do not’s
1 Do keep ring counts separated by two (2, 4, 6, 8). Do not use a
ring count of one (1) on any unit .
2 Do keep a list of the order of units to call.
Do not wait more than 1½ minutes between calls as the sleep
function in the units will end. Tec Basic will stop and give you a
message if the Unit Id does not match the expected number.
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Helpful Hints and Short Cuts

Helpful Hints
Tec Basic is designed to use the SMALL(Normal Size) font selection in the Control Panel
- Display - Settings - Font Size. Choosing Large fonts will cause some wording not to be
displayed correctly. A “Print View Button is on the data pages. This allows you to print your
data and settings using your default printer.
General
The [TAB] key [forward] and [Shift Tab] key [backwards] also moves from text window to
text window. The [Enter] key behaves like the [TAB] key as well.
The minimum computer specified will operate correctly when Tec Basic is the only program running. Larger computers with more memory will operate faster . Other programs
should be exited first.
Data Files
Data files and the backups are compatible with Microsoft Access Version 7.0 or higher and
may be used to generate reports from the data if desired. Do not convert your data or
add,subtract or rename any fields with the Access Data Manager as it will cause Tec Basic to stop working later.
Remote Data Storage
If you wish to archive your data and/or backup data in another location, copy the files in
your Selcom directory. If you did a standard install, the files are in
C:\Program Files\ Tec Basic\*.mdb . The backup files are in
C:\Program Files\ Tec Basic\Backup\*.md*. Make a copy these files to a location of your
choice.
Version Number
When talking to tech support, your serial number and the version number (shown on the
Help - About menu selection) is very important. The Unit Firmware version is displayed in
the “Edit TEC Unit Data” screen. Check them before you call and have them ready .
Directory
Refresh retrieves a new copy from the disk and resets the records to the name order.
Selecting a name to edit automatically sets the record to be sent to the unit on the next
update.
To print a partial Directory, sort by the type of request, then use the elevator bar to view
what you want to print and press "Print View".
Edit Directory
Return to view button updates the record.
Update Record Button is present to allow user to continue to enter new records as in
Add New Button - complete the record - Update Record Button(save it) - Add New
Button - etc...
In the Directory EDIT screen the triangles located on the lower record bar allow you to
move through the directory. The Left Bar-triangle moves to the first record, the triangle
moves one record towards record one. The right triangle moves one record towards the
last record and the Right Bar-triangle moves to the last record in the directory.
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Add New Names

14

Main Screen

8

Add New TEC Unit

25

Memory Requirements

6

Authority Levels

11

Modem Setup

32, 33

Auto Tune

13

MUI Features

28

Name, Entrance

20

Bulk Loading

24

Name, in directory

14
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14

Phone, in directory

14

Phone Line Delays

13

Program Organization

10

Dialing Setup
Directory Title Change
Edit Directory

14
6
14-16

Edit TEC Unit Parameters

18

Entrance Names

20

Entrance Setup

20

Error Control

32

Getting Unit Data

34

Hard Disk Space

6

Help, Built in

8

Hints for Users

38

Hide, Names in directory

15

ID, Unit (Ring Count)

18

Install Software

Login Passwords
Long Distance Dialing

6, 7

11
15, 26

Program Setup

6-7

Ring Count (Unit ID)

18

Sending Unit Data

35

Setup Software

6

Setup Wizard for TEC Unit

25

Short Cuts

38

Sleep MUI

26

Unit ID (Ring Count)

18

Unit System Parameters

18

Worksheets, Directory

41

Worksheets, Unit Setup

40

Wizard, Unit Setup

22
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WORK SHEET - COPY BEFORE USING

NEW UNIT SETUP
PREPARE INFORMATION BEFORE HAND
Unit Description (name) File name Address City TEC Model Phone Number Capacity Unit Phone Number Unit ID (Rings to Answer) Modem String Modem Select Baud Rate 08/02
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Directory Worksheet

BEFORE WRITING - COPY THIS FORM
USE THIS WORK SHEET TO ASSEMBLE YOUR DIRECTORY
CODE
NUMBER
1-6
Numbers

NAME
up to 14 Characters

PHONE NUMBER
up to 14 Numbers

PIN
NUMBER
1 to 6 Digits
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How to get into Terminal Mode

It is occasionally necessary to directly program the contents of the TEC units’ memory. Using the
Terminal selection from the TEC Basic 6 Options menu you can do this.
1) Select the desired site.
2) Click on Options.
3) Click on Terminal.
4) Click on File, then Place Call or click on the telephone icon.
If connecting with a serial connection, you must press the [ESC] key for the unit to prompt you for the
password. If you do not press [ESC], the unit will send transaction data to the terminal as it occurs.
If connecting with a modem, Tec Basic 6 will call the TEC unit and prompt you for the password by
changing the screen from white to black and prompting with the word PASSWORD: This is the
programming password found in your System CFG menu. Key in the 6 digit password and press
“Enter” You should get a selection that says Main Menu and has 9 selections available (Fig 1.). These
selections correspond to the sections in the TEC Manual that came with your TEC product. In the
examples that follow, an example shows Menu 9-1, the Info screen. The next section heading is
referring to the manual section that describes the clock function (Menu 5). The next example shows
setting the clock time which is something that would be required twice a year in order to go on (or off)
daylight savings time.
FINDING YOUR FIRMWARE VERSION

Fig 1. Main Menu

Fig 2. Menu 9

Fig 3. Menu 9-1 (Info) Note: Shows Firmware Version

CHANGING THE CLOCK
Changing the clock involves the time, day of the
week and the date in sequence. In order to change
the time you need to be prepared to enter all of the
parameters in sequence. NOTE: ONCE TIME/
DATE PROGRAMMING HAS BEGUN, ALL
SELECTIONS MUST BE COMPLETED FOR
CHANGES TO TAKE EFFECT.
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AM—PM Time

Military Time

12 Midnight

0

12 Noon

12

1 PM

13

2 PM

14

3 PM

15

4 PM

16

5 PM

17

6 PM

18

7 PM

19

8 PM

20

9 PM

21

10 PM

22

11 PM

23

Figure 4. Shows progression for changing the time and date.
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